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1. Work presentaƟon

The idea behind this project is to enhance the communicaƟon capabiliƟes of the SEcube™ board,
making it able to communicate through a new interface, not supported naƟvely by the SEcube™
Chip.
The developed IP core is syntheƟzable onto the SEcube™ FPGA, and makes use of its availale
I/O pins to communicate with other devices using Quad-SPI. The transmission rate that can be
achievedwith the provided design is 110MB/s, which consƟtutes a great improvement (2x faster)
over the classic SPI interface already available on the SEcube™ .
This document is meant to present all the necessary informaƟon about the core. StarƟng from
a brief explanaƟon of the protocol, the architecture of the core will be presented and explained,
followed by a step-by-step guide explaining how to embed it in the mulƟ-IP environment already
available for the FPGA. Finally, an example project is presented, describing how it is possible to
use the core to communicate with another device through Quad-SPI.
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2. Overview

Quad-SPI is a communicaƟon standard interface which extends the classical SPI, widely spread in
the embedded system domain. As for Quad-SPI, it is mainly used for interfacing with embedded
memories, as it gives the possibility to write/read data at a sustained rate. It allows an half-duplex
communicaƟon between two devices, one master and one slave, which can exchange 4 bits per
clock cycle, as the name suggests, rather than a single one as in SPI.
More specifically, the lines involved in the transmission are 6. These are:

• SCLK: it is the clock of the communicaƟon, always generated by the master, used for syn-
chronizaƟon;

• CS: it is the chip-select signal, connected to the corresponding slave, and it is acƟve low. In
case there is only one slave, this line is not strictly required;

• SDIO[3:0]: the 4-bit bidirecƟonal data bus, which carries the bits to be transferred.

Beside the physical interface, there are few required parameters, which are introduced here
through a simple example.
At first, when there is no transmission occurring, the SCLK signal remains idle on a constant level,
depending on the clock polarity parameter (hereinaŌer referred as CPOL):

• CPOL = 0means that the clock is low when idle;

• CPOL = 1means that the clock is high when idle.

Whenever the master wants to communicate with a slave device, the chip-select signal is driven
low by the master, and kept low for the enƟre transmission window. The master then generates
n clock cycles. Every clock cycle, 4 bits (1 nibble) are sent, either by the master or by the slave.
Therefore, the other two parameters of the transmission that must be known are the number
of nibbles to transmit (because the master has to generate the clock signal for a precise number
of cycles), and the frequency of the clock signal. This last is needed in order to carry out the
transmission correctly, because the slave device must be able to support the frequency of the
clock generated by the master. During the transmission, data changes at every clock edge, and is
sampled on the opposite clock edge. This last feature is defined by the last parameter, the clock
phase (hereinaŌer referred as CPHA):

• CPHA = 0means that data changes on traling edge and it is sampled on leading edge;

• CPHA = 1means that data changes on leading edge and it is sampled on trailing edge.

Finally, to complete the transmission, CS signal is deacƟvated and the SCLK returns idle. In Table 1,
all the possible combinaƟon of clock phase and clock polarity are summarized, with the resulƟng
behavior.

CPOL CPHA Idle CLK Data change Sampling
0 0 0 Falling Rising
0 1 0 Rising Falling
1 0 1 Rising Falling
1 1 1 Falling Rising

Table 1: Behavior for each combinaƟon of CPOL-CPHA
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Let us assume a device needs to transmit 6 nibbles to another one. Before starƟng, the previously
discussed parameters are to be defined according to desired behavior. In this case, we assume
that CPOL is set to 0 and CPHA to 1. Then, the CS signal is deacƟvated, and on each rising edge of
the clock, a nibble is sent. On the falling edge, the receiver samples the I/O lines. In Figure 1, the
waveforms for the transmission are shown.

Figure 1: Waveforms related to a transmission of 24 bits with CPOL = 0, CPHA = 1



Quad-SPI core for FPGA on SEcube™
Document ClassificaƟon: Public

Page 9 of 25
Release: 001

3. System Architecture and Behavior

This SecƟon is meant to give an overview of the implemented design. NoƟce that the core is
meant to work with the mulƟ-IP architecture already designed for the SEcube™ FPGA1, based on
the IPManager component. To keep things brief, the structurewill not be presentednor explained
again, except in case of some examples, where it is necessary.

3.1. Design overview

The design is composed of two cores:

QSPI CORE IdenƟfied by ID = 0x01, it is the core providing QSPI capabiliƟes;

LED-BLINKER CORE IdenƟfied by ID = 0x02, it provides the possibility to control the LEDs of
the SEcube™ DevKit for debug purposes, as will be beƩer explained later.

Plus, the FPGA hosts also the IP Manager component and a Data Buffer of 64 16-bit shared mem-
ory locaƟons for exchanging informaƟon with the CPU. Therefore, the overall architecture that
will be mapped onto the FPGA is the one in Figure 2.

Figure 2: FPGA internal architecture.

3.2. LED-BLINKER Core

This secƟondescribes the addiƟonal core that has been inserted for tesƟngpurposes in the design,
since it is not necessary for Quad-SPI to work.
The core is idenƟfied by the ID = 0x02. It is iniƟally inacƟve, waiƟng for a request coming from
the CPU. When it comes, the core reads a byte from the address 0x01 of the data buffer. These
8 bits are then used to drive the 8 LEDs of the FPGA accordingly. In pracƟce, if a bit is zero, the
corresponding led will be turned off, otherwise it will be turned on. The bit are mapped as shown
in Figure 3.

1https://www.secube.eu/site/assets/files/1164/wiki_fpga_-_rel004_190403.pdf

https://www.secube.eu/site/assets/files/1164/wiki_fpga_-_rel004_190403.pdf
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Figure 3: The mapping between the bit of the word read from the data buffer and the led on the
SEcube™ .

The core can be used to visualize the word wriƩen by the CPU. Therefore, it will be parƟcularly
useful when tesƟng the recepƟon of bits over Quad-SPI. As a maƩer of fact, when the SEcube™
receives data over Quad-SPI, it can be forwarded from theQuad-SPI core to the IP-BLINKER, check-
ing whether they are the expected bits or not. The core is really simple and low-area, so it does
not affect the overall design significantly.

3.3. Quad-SPI Core

The core, whose architecture is shown in Figure 4, is structured as an FSM-D. Its acƟviƟes can be
summarized into twomain groups: reading/wriƟng from/to the data buffer to communicate with
the CPU, and sending/receiving data through Quad-SPI to communicate with a slave device. In
the following, the communicaƟon with the CPU is dealt from an high-level point of view. For a
detailed explanaƟon of the protocol, how transacƟons are opened and similar, please refer to the
manual available online2.
AŌer the reset, or aŌer any operaƟon is finished, the core enters in an IDLE state. At each

clock cycle, it monitors the enable signal coming from the IP Manager. When that signal is as-
serted, meaning that the CPU has requested the funcƟonaliƟes of the core, this last checks for
the received OPCODE. According to it, three are the possible choices. Either the CPU wants to
configure the core, or it wants to send/receive some data. Each one of them is discussed right
aŌer.

3.3.1. ConfiguraƟon

The phase is entered whenever the core in IDLE state receives a request from the CPU with the
OPCODE = 0x00. As discussed in SecƟon 2, Quad-SPI requires some parameters before the trans-
mission can take place: the clock frequency, the clock polarity and the clock phase. This state is
commiƩed just to their definiƟon. Therefore, as soon as it is entered, the core reads from the
data buffer two 16-bit words, from addresses 0x01 and 0x02 respecƟvely. They are supposed to
contain all of the three parameters. More specifically, the structure of the two words is in Figure
5 and Figure 6 respecƟvely.
As it can be seen, the clock divisor is expressed on 24 bits, allowing to use a clock frequency which
is really low (that will be really useful for debugging purposes). The minimum value this parame-
ter can assume is 1. Once they have been read, they are stored inside the dedicated registers, to
be used for all the future communicaƟons up to a new reconfiguraƟon. NoƟce that this configu-
raƟon must be performed at least once before any other operaƟon, otherwise the core will not

2https://www.secube.eu/site/assets/files/1164/wiki_fpga_-_rel004_190403.pdf

https://www.secube.eu/site/assets/files/1164/wiki_fpga_-_rel004_190403.pdf
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Figure 4: Overview of the architecture of the QSPI core.

Figure 5: Structure of the control word read from address 0x01 of the data buffer.

work properly. Once the configuraƟon registers are updated, the core exits the CONFIGURATION
state and goes back to IDLE, waiƟng for the next request.

3.3.2. Send

This state is in charge of establishing a communicaƟon with the slave device that is supposed to
be connected to the pin of the FPGA, as wewill see in the next SecƟon. It is entered whenever the
core in IDLE state receives a request from the CPU with OPCODE = 0x01. In order to handle the
transmission, the core needs to know howmany nibbles are to be sent. Thus, first the core reads
fromaddress 0x01 of the data buffer this value. This is loaded in the corresponding register, where
it will be kept unƟl the end of the transmission. Once the number of nibbles is known, the core
reads from the data buffer the exact number of words, considered that one word is composed by
four nibbles.
The size of the transmission has been fixed to 1024 as a technical choice. This means that for each
transacƟon the CPU opens with the core, a transfer of 2KB at maximum is allowed. In order to
make this possible, the core reads the buffer circularly. Therefore, once the end is reached, if the
number of words to send is greater than 63, the core starts reading again from address 0x01.
An internal storage is needed to store the data read from the data buffer. To this end, the RAM
available on the FPGA has been exploited. This choice helps reducing the space occupied by the
core, leaving space for the co-presence of other cores. The dimension of the RAM has been fixed
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Figure 6: Structure of the control word read from address 0x02 of the data buffer.

to 2KB (maximum size of the transfer). To sum up, when this state is reached, one word is read
from the data buffer at CPU write cycle, and is stored inside the internal RAM. In case the end of
the data buffer is reached, the core starts reading again from address 0x01. This process repeats
unƟl the words are over, and we have all of them stored inside the internal storage of the core.
At that point, according to how to communicaƟon with the core has been opened, there are two
possible scenarios:

• The CPU opened a transacƟon in polling mode, so it waits for the transmission to be over,
without closing the transacƟon;

• The CPU opened a transacƟon in interrupt mode, so the transacƟon is closed as soon as the
last word is wriƩen inside the internal RAM.

In both cases, when the reading process is terminated, the core enters in the transmission phase.
Hence, the CS signal is driven low, signaling to the slave device that a transmission is about to
start. According to the parameters, which have been configured as explained in SecƟon 3.3.1, the
core starts generaƟng the clock signal (SCLK) for the transmission with the proper frequency, and
the data (read from the internal RAM) is sent on the four data lines (SDIO[3:0]) according to the
CPOL-CPHA configuraƟon, as explained in Table 1. Obviously, when the number of sent nibbles
reaches the limit, the core asserts the CS signal, so that the slave knows that the transmission is
over, the SCLK returns idle, and the core exits from the transmission state. Then:

• If the CPU opened a transacƟon in polling mode, the core writes the unlock code at address
0x3F. The CPU, which is conƟnuously reading from that address, reads the unlock code as
soon as it is wriƩen, and disables the core;

• If the CPU opened a transacƟon in interrupt mode, the core raises an interrupt and wait for
an acknowledgement. Sooner or later, the CPU will respond, and the core will be disabled.

At that point, it returns to the IDLE state, waiƟng for another transacƟon.

3.3.3. Receive

This state is enteredwhenever the core in IDLE state receives a request from the CPUwithOPCODE
= 0x02. As already discussed for the sending part, the core needs to know howmany nibblesmust
be received, because the SCLK signal must be generated for that precise number of Ɵmes. Hence,
the core expects the CPU to write at address 0x01 of the Data Buffer the expected number of
nibbles. Once it is read, it is stored inside the corresponding register. In case the transacƟon
was opened in polling mode, the CPU waits, otherwise it is closed. At that point, the core enters
the RECEIVING state by driving low the CHIP SELECT signal, to noƟfy the slave that it is ready to
receive data. It generates the SCLK with the frequency set during the configuraƟon phase, and
samples the bits on the four data lines, according to CPOL and CPHA, as explained in Table 1. Also
in this case, the received data is stored inside the internal RAM, one nibble per Ɵme. Once the
end of the expected nibbles has been reached, the clock returns idle, the CS signal is asserted and
the communicaƟon stops. At that point, all the data are in the internal RAM of the core, but they
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must be read from the CPU. According to how the transacƟonwas opened, there are two possible
scenario:

• The CPU opened the transacƟon in polling mode, so the core unlocks the CPU wriƟng the
unlock code at address 0x3F, and then it resumes;

• The CPU opened the transacƟon in interruptmode, so the core raises an interrupt andwaits
for the CPU to respond. As soon as it does, the CPU sends an acknowledgement to the core,
so that it can resume.

Whatever the modality, once the core resumes its acƟvity, the CPU starts waiƟng for a fixed
amount of Ɵme. This is necessary because the core needs some Ɵme to copy the content of
the internal RAM inside the Data Buffer. Once this Ɵme is elapsed, the CPU reads from the Data
Buffer the data received. However, as already stated, the maximum size per transfer is 2KB (1024
words of the data buffer), which means that once the core has copied 63 words to the Buffer, it
has to stops. Meanwhile, the CPU, which was waiƟng for a certain amount of Ɵme (long enough
to allow the core wriƟng 63 words), reads the data. Each Ɵme a read is completed, the core re-
ceives a signal proving that the CPU has read a word. Once the core has received 63 Ɵmes this
kind of noƟficaƟon, it resumes the copying process (starƟng again from address 0x01), whereas
the CPU stops reading, and it starts waiƟng again. This process repeats unƟl all thewords received
through Quad-SPI from the slave are read by the CPU. NoƟce that, even though the number of
words is lower than 63, to keep things simple, the CPU sƟll waits for the Ɵme necessary to write
63 words. Anyhow, when the process is over, the CPU disables the core, which returns to the IDLE
state waiƟng for the next transacƟon.
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4. ApplicaƟon Program Interface

This Chapter describes the communicaƟon driver developed for interfacing the user applicaƟon
and the Quad-SPI core on the FPGA.
For a correct communicaƟon, the complete driver should be composed of two layers: a high- level
one, composed of the specific funcƟons formanaging the task of each IP core, and a low-level one,
containing the low-level funcƟonaliƟes for the communicaƟonwith the FPGA. The developed APIs
take into account the mutual concurrency of high-level drivers.
The project presented here focuses on providing the applicaƟon programmer a reliable high-level
layer, over which it is possible to create the program exploiƟng all the funcƟonaliƟes of the core.
Before using any of the funcƟons described in this Chapter, the FPGA should be configured to
support the IP Manager environment, without forgeƫng to insert calls to

B5_FPGA_Programming();
FPGA_IPM_init();

in order for the FPGA to be ready. FPGA_IPM_init() also iniƟalizes a semaphore to resolve
concurrency issues, as we will see later. Once it is done, you can start wriƟng your own program.

4.1. High-level driver

The high-level communicaƟon with the core is implemented by the funcƟons declared in the
header file “qspi_fpga.h”. Such funcƟons are supposed to be called by the user applicaƟon code,
without having almost any knowledge of the specific hardware implementaƟons and of the de-
tails about the micro-controller and the FPGA provided by SEcube™ . Because of the nature of
the concerned core , three types of APIs have been provided. These are:

Configuration - Used to configure the core;

Transmit - Used to send data from the SEcube™ to a slave device;

Receive - Used to receive data from a slave device.

Due to foreseen usability and the user convenience, the transmission funcƟon supports three
different width: 8, 16 and 32 bit. The user should only pass the address where the data is stored,
and then it will be treated differently (as 8, 16, or 32 bits wide) according to the called funcƟon.
The funcƟon is responsible of making the data compaƟble with the interface of the core. As for
the recepƟon, data is considered only 16-bit wide, and it is wriƩen to the address provided by the
user. When finished, it is up to the user converƟng the data to the appropriate data length before
using it. Right-aŌer, the APIs and their explanaƟon are listed.

int FPGA_QSPI_CONF(uint32_t clk_divisor, uint8_t clk_polarity,
uint8_t clk_phase)

This funcƟon is used to configure the Quad-SPI core, therefore it is mandatory to call it at the
beginning of any applicaƟon that makes use of the core, otherwise it will not work as expected.
The parameters are:

• clk_divisor, which sets the clock divisor, that will be used to obtain the desired clock
frequency starƟng from the one of the FPGA. It can be any number between 1 and 224− 1;

• clk_polarity, which sets the polarity of the clock. It can be 0 or 1;

• clk_phase, which sets the phase of the clock. It can be 0 or 1.

For a detailed explanaƟon of these parameters, please refer to SecƟon 2.
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int FPGA_QSPI_SEND_8bI(uint16_t n_nibbles, uint8_t* data, int
interruptMode);

This funcƟon allows to open a transacƟonwith the core in sendmode, to transmit 8-bit wide data.
The following parameters are required:

• n_nibbles: it indicates howmany groups of 4 bits the user is willing to send. For example,
16 bits are composed of 4 nibbles;

• data: it is the iniƟal address in memory where the data to be sent is stored;

• interruptMode: it indicates how the transacƟon should be opened: polling if 0, interrupt
if 1.

The opening of the transacƟon is possible only if there are no acƟve transacƟons. Any other
transacƟon is blocked by the soŌware semaphore. The procedure to open a transacƟon follows
these steps:

1. Check if the transacƟon can be established: if not, the request is rejected;

2. Lock the resource (FPGA) by decremenƟng the semaphore;

3. Update control variables to the new values;

4. Perform a write operaƟon at address 0x02 of the buffer;

5. Send a posiƟve response to the calling funcƟon if everything went fine.

The funcƟon returns a value(1) that noƟfies whether the operaƟon was correctly performed.

int FPGA_QSPI_SEND_16bI(uint16_t n_nibbles, uint16_t* data, int
interruptMode);

int FPGA_QSPI_SEND_32bI(uint16_t n_nibbles, uint32_t* data, int
interruptMode);

These two funcƟons are basically the same of the previous one, except for the fact that they deal
with 16-bit and 32-bit wide data respecƟvely.

int FPGA_QSPI_RECEIVE_16bI(uint16_t n_nibbles, uint16_t* data,
int interruptMode);

This funcƟon is used to received data from a slave device. As already stated, data is treated as
16-bit wide. The parameters are:

• n_nibbles: it indicates how many groups of 4 bits the user is willing to receive;

• data: it is the iniƟal address in memory where the user wants to store the received data;

• interruptMode: it indicates how the transacƟon should be opened: polling if 0, interrupt
if 1.
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4.2. Concurrency issues

Concurrency is a big concern that may affect the correct behavior of the system if not correctly
managed. As we said, the management is operated through the implementaƟon of a semaphore
inside the driver that allows the execuƟon of one and one only transacƟon at the Ɵme. The
semaphore is managed by the following funcƟons:

1. FPGA_QSPI_CONF(), that configures it;

2. FPGA_QSPI_SEND_XbI(), that checks the value of the semaphore. In case the resource
is unlocked, the funcƟon zeroes the semaphore and allows the beginning of the current
transacƟon. Otherwise, the funcƟon immediately returns with an error;

3. FPGA_QSPI_RECEIVE_16bI(), that increments the semaphore releasing the resource if
and only if there is an acƟve transacƟon and the caller of the funcƟon is the caller that has
opened the acƟve transacƟon.
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5. User Manual

The following Chapter is commiƩed to explaining how to use the core, starƟng from its inserƟon
in the development environment.

5.1. Core installaƟon

To start with, you need to add the two cores to the working environment, that is the one contain-
ing the IP Manager and the Data Buffer. Hence, you need a custom Device-Side SEcube™ project
opened in Eclipse, ready to work with the FPGA available on the SEcube™ . To do so:

1. Download the files related to the IP Manager and the data buffer from the SEcube™ site3;

2. Create a new Device-Side project by following the steps that are listed in the related docu-
mentaƟon. Be sure to add all the necessary files to communicate with the FPGA4;

3. Create a new Laƫce Diamond™ project. When you are asked to import the VHDL files, be
sure to include thefiles named “CONSTANTS.vhd”, “DATA_BUFFER.vhd”, “IP_MANAGER.vhd”,
which you downloaded at point 1. Moreover, you must add all the VHDL files related to the
Quad-SPI and the Led Blinker. These files are located inside the folder named ”VHDL”;

4. Proceed with the creaƟon of the project, as explained in SecƟon 6.3.1 of the IP Manager
documentaƟon;

5. Once the project is created, synthesize it (check that no Ɵming errors are present) and pro-
duce the files containing the bitstream by following the steps contained in SecƟons 6.3.2
and 6.3.3 of the IPManager documentaƟon. You should have obtained two files with name
ending with “_algo.c” and “_data.c”, which will be used later;

6. Proceed by adding everything to the Device-Side project, as explained in SecƟon 6.4 of the
IPManager documentaƟon. When you are asked to subsƟtute the content of the two arrays
in the file “TEST_FPGA.h”, use the files obtained at point 5;

Now the bitstream describing the architecture is staƟcally saved on the flash memory image to
be programmed into the device. To use its funcƟonaliƟes, you need to include the files containing
the correlated APIs, with the following steps:

1. To import the necessary files in your Device-Side project, select ”File » Import…”, then
“Filesystem” and press “Next”

2. Browse to the directory where the API libraries for the Quad-SPI core are located, which is
called ”API”

3. Select all the files inside the folder (”qspi_fpga.c”, ”qspi_fpga.h” ). You might want to set
also “DesƟnaƟon Folder” to “SEcubeDevBoard/ApplicaƟon/src” and then press “Finish”

4. Open the file ”Fpgaipm.h” and include the file ”qspi_fpga.h” by inserƟng the following line
aŌer all the others inclusions:

#include "qspi_fpga.h"

5. In the same file, modify the funcƟon EXTI9_5_IRQHandler(), which is located at the
boƩom of the file, adding the following lines to the switch-case statement, necessary to
call the interrupt handler when an interrupt request comes from the core:

3Download the files here: https://www.secube.eu/site/assets/files/1164/fpga_190403.zip
4https://www.secube.eu/site/assets/files/1164/wiki_fpga_-_rel004_190403.pdf

https://www.secube.eu/site/assets/files/1164/fpga_190403.zip
https://www.secube.eu/site/assets/files/1164/wiki_fpga_-_rel004_190403.pdf
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case 1:
handle_IR();
break;

Now the core is correctly inserted in the environment. You can now create your own program, in
the file ”main.c”, and use the core to send and receive data over Quad-SPI, as described in secƟon
4. Once finished, you may want to program the SEcube™ , by following these simple steps:

1. Save the changes to all files

2. Go to ”project » Build ConfiguraƟon » Set AcƟve” and ensure the Ɵck is on ”Release”

3. Build the project

4. Connect the SEcube™ to the PC

5. Flash the produced executable on the device by right-clicking on it in the Project Explorer
and selecƟng the Release binary under ”Target » Program Chip” (i.e., select the label con-
taining the string “/Release”)

When the process starts, the LEDs associated to the FPGA will be set in a weak pull-up state,
meaning that the FPGA is being programmed. At the end, they should turn off. As soon as they
turn off, the program you wrote starts execuƟng.
Youwill need a seconddevicewhich should beprogrammedaccordingly, connected to the SEcube™
, for sending and receiving data over Quad-SPI. Read SecƟon 5.2 for an example of how a possible
communicaƟon can be established.

5.2. A first project: communicaƟng with Arduino

To check whether the procedure in SecƟon 5.1 has been executed correctly without errors, and
prove that the core is actually working, you may want to carry out a simple experiment. The pur-
pose of this SecƟon is to provide a tutorial that illustrates, step-by-step, how it is possible to send
and receive data through the core. The slave device that will be used in the communicaƟon is an
Arduino™ UNO board, from Arduino™ . It has been chosen because it is easy-to-use, cheap, and
can be reused for a lot of other projects. Moreover, it is supported by all the operaƟng systems,
its setup takes few minutes, and there is a lot of documentaƟon online, which makes the devel-
opment really easy.
As already said, Quad-SPI allows to send and receive data. Hence in the following, we will test the
core in both operaƟng condiƟons. First, we will be using the Arduino™ board to read data sent
by the SEcube™ , and then we will use it as a transmiƩer, sending the data to the SEcube™ .

5.2.1. Hardware resources

The hardware you will need is:

• PC

• SEcube™ DevKit

• Arduino™ UNO board (it can be bought online for 20€)5

• 6 F/M jumpers, to connect the Arduino™ UNO to the SEcube™ .

5https://store.arduino.cc/arduino-uno-rev3

https://store.arduino.cc/arduino-uno-rev3
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5.2.2. SoŌware resources

In addiƟon to the soŌware necessary to create the Device-Side project and synthesize the VHDL
code, you will need the Arduino IDE, to program the Arduino UNO board. It can be downloaded
from the Arduino official site6. The supported operaƟng systems are Windows, Linux and Mac
OS.

5.2.3. Arduino setup

Let’s start by gaining some familiaritywith theArduino™board and its development environment.

1. Start by downloading the Arduino IDE from the official website, choosing the version ac-
cording to your operaƟng system, and install it

2. Once the installaƟon is terminated, open it

3. Connect the Arduino™ UNO board to the USB port of your PC

4. In the Arduino IDE, go to ”Tools » Board”, a list of boards should appear. Select the ”Ar-
duino/Genuino UNO” board, as in Figure 7

Figure 7: SelecƟng the Arduino™ Uno Board

5. Select ”File » Examples » 01.Basics » Blink”. A new window, containing some code should
open. It is a script that makes the LED of your Arduino™ UNO blink

6https://www.arduino.cc/en/Main/Software

https://www.arduino.cc/en/Main/Software
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6. Select ”Sketch » Upload”. Now the code is being downloaded on the board. At the end
of the process, the LED should start blinking, meaning that everything has been setup cor-
rectly.

You may noƟce that the script is made of two funcƟons: setup() and loop(). The first one
should contain code that is executed only one Ɵme, at the beginning. On the contrary, the code
inside the loop() funcƟon, is executed repeatedly aŌer the setup() has finished. This must be
the structure of every Arduino program.
Another important feature that we will use for our communicaƟon example is the Serial Monitor.
You can open it by clicking on the icon in the top-right corner of thewindow, see Figure 8. It shows
the value that are being printed by your program. Wewill use it to print the data we are receiving,
or sending.

Figure 8: The serial monitor where data is printed.

If there are no errors, you can proceed to the next secƟon, otherwise, be sure to resolve any issue
before moving on.

5.2.4. ConnecƟng the two devices together

This secƟon contains informaƟon related to the connecƟon of Arduino™ to the SEcube™ .
As stated in SecƟon 2, the communicaƟon over Quad-SPI uses 6 lines: 1 for the clock, 1 for the
chip select, and 4 lines for the data. In Figure 9, you can look at which are the pins of the SEcube™
that are connected to the Quad-SPI core, and how they are used. These lines have to be aƩached
to 6 pins on the Arduino™ UNO. More precisely, if you are going to use the code associated to
this document, the pins are configured in this way:

• D12 for the clock

• D13 for the chip select

• D8-D7-D4-D2 for SDIO[3:0] respecƟvely.

However, this configuraƟon is not mandatory. You can use whatever digital pins of the Arduino™
UNO, as long as you change the code accordingly. When you are finished, the connecƟon should
look like in Figure 10. Finally, connect both the SEcube™ and the Arduino™ to your PC.
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Figure 9: The pins of the SEcube™ that are used by the Quad-SPI core.

Figure 10: Overview of the connecƟon between the SEcube™ and the Arduino™ UNO
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5.2.5. TesƟng Quad-SPI - Send

Let’s deal with the situaƟon inwhichwewant to use the SEcube™asmaster of the communicaƟon
to send some data to the Arduino™ UNO. We are going to work in polling mode, but nothing
changes if interrupt is used instead. The necessary code is contained in A.1. An explanaƟon of
the code follows, to make things clearer.
First of all, considering how the Quad-SPI works, as explained in SecƟon 2, we must iniƟalize the
core by seƫng its parameters: clock divisor (whichwill be used to determine the clock frequency),
the clock polarity, and the clock phase. In this example, we will be using a really high clock divisor,
resulƟng in a slow transmission. This choice is due to the fact that we are using as a slave device,
a board that does not provide naƟve support for Quad-SPI. Therefore, the piece of code we are
going to use, is a simple loop that reads the value on the four digital pins connected to the data
pins of the SEcube™ . This implies that, in case a lower clock divisor is uƟlized, we will not be able
to read all the data through the Arduino™ UNO because of the high speed of the transmission.
Therefore, for the purpose of the experiment, do not change it. As for the clock polarity and the
clock phase, both have been set to one.
Once the core has been configured, we must declare the array of the data we want to send. In
this case, we have declared an array of 10 numbers, each one expressed on 16 bits. Then, using a
for loop each element is iniƟalized, from 0 to 9. Once completed, we can send the data through
Quad-SPI by simply calling the associated funcƟon. Remember that the funcƟon requires also the
number of nibbles we want to send, that is easily obtained:

nibbles =
(words ∗ width)

4
(1)

To embed it in your project, follow these steps:

1. Open the device-side project

2. Open the file ”main.c”

3. Copy paste the code right aŌer the call to the funcƟon B5_FPGA_Programming()

4. Save the changes to all files and build the project

5. Connect the SEcube™ to the PC

6. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under ”Target » Program Chip” (i.e., select the label containing the string “/Release”)

7. Wait few minutes. The LEDs of the FPGA should be set in a weak pull up state, meaning
that it is being programmed, and at the end, all of them should be turned off.

The part related to the SEcube™ is over. Now we need the Arduino™ to be able to read the data
we are sending. To do so, follow these steps:

1. Open the Arduino IDE

2. Go to ”File »Open”, and select the file ”QSPI-Receive.ino”, located in the folder ”Arduino/QSPI-
Receive”

3. Go to ”Sketch » Upload”, and wait for the process to finish

4. Open the serial monitor, by clicking on the icon placed in the top-right part of the screen

5. In the serial monitor page, be sure that the baud rate is set to 19200.
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The code contained in the Arduino script is straighƞorward. As explained in SecƟon 2, when the
master starts the communicaƟon, the CS signal is set to 0.
Therefore, since the arduino board is the slave device, it waits for the chip select signal to go to 0.
Once a zero has been read, 4 bits are read on each rising edge of the clock (because we set CPOL
= 1 and CPHA = 1, check the Table 1 to see when the sampling shall be performed), and they are
printed on the serial monitor.
Now the code for both devices are ready. If they are not connected to each other already, please
connect them as described in 5.2.4. When everything is connected, press the RESET buƩon (it is
the first buƩon next to the LEDs of the FPGA) on the SEcube™andwait fewminutes. Remember to
not close the Serial Monitor. At some point aŌer the reset (as soon as the FPGA is programmed),
the SEcube™ should start sending the bits, which should appear on the serial monitor.

5.2.6. TesƟng Quad-SPI - Receive

The procedure and the moƟvaƟons required for tesƟng the recepƟon mode, are almost equal to
one used for the test of the transmission mode. As first, let’s consider the code for sending data
from the Arduino™ board, which is located in ”Arduino/QSPI-Send”. IniƟally, the slave is waiƟng
for the master to iniƟate the communicaƟon, therefore it waits unƟl the chip select signal is set
to zero. As soon as a zero is detected, each falling edge of the clock, a new value on the digital
pins is wriƩen. When the chip select will be asserted again from themaster, the process will stop.
To upload this code:

1. Open the Arduino IDE

2. Go to ”File » Open”, and select the file ”QSPI-Send.ino”, located in the folder ”Arduino/QSPI-
Send”

3. Go to ”Sketch » Upload”, and wait for the process to finish

4. Open the serial monitor, by clicking on the icon placed in the top-right part of the screen

5. In the serial monitor page, be sure that the baud rate is set to 19200.

On the other side, the SEcube™ will now be in charge of receiving and storing the data that Ar-
duino™UNOwill send. The code to add in the main file of the SEcube™ project is reported in A.2.
A brief explanaƟon follows.
Once the core has been iniƟalized with its parameters, the funcƟon to receive data is called, and
the data will be stored in the desired array passed to the funcƟon. Once the recepƟon is over, you
may want to check what you have received. This is where the addiƟonal core, the LED-BLINKER
(secƟon 3.2) comes in help. Once the communicaƟon with Arduino™ is over, for each 16-bit
word we have received, we split it in two parts of 8-bit each. Each of these two parts is sent to the
LED-BLINKER core. In this way, the LEDs on the SEcube™ will turn on/off, according to the data
received, and the correctness can be proved. To embed the code in your project, follow these
steps:

1. Open the device-side project

2. Open the file ”main.c”

3. If you previously added the code related to SecƟon 5.2.5, please remove or comment it

4. Copy paste the code right aŌer the call to the funcƟon B5_FPGA_Programming()

5. Save the changes to all files and build the project
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6. Connect the SEcube™ to the PC

7. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

8. Wait few minutes. The LEDs of the FPGA should be set in a weak pull up state, meaning
that it is being programmed, and at the end, all of them should be turned off.

NoƟce that, if you have already uploaded your code on the Arduino UNO, during the program-
ming phase the CS pin is set to 0. This is recognized from Arduino™ as if it were the start of the
transmission, even if it is not. Therefore, you should noƟce on the serial monitor that while the
FPGA is being programmed, the transmission start. If this is the case, once the FPGA has been
programmed, re-upload the program to Arduino™ .
At some point, you should see on the serial monitor of Arduino that the transmission is started.
When the transmissionwill be over, the LEDs of the SEcube™will reflect that data sent by Arduino.
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A. Appendix

Here are reported all the piece of code used in the example.

A.1. SEcube™ - Send

FPGA_QSPI_CONF(16777215, 1, 1);
uint16_t data_to_send[10];
for (int i = 0; i < 10; i++) {

data_to_send[i] = i;
}
FPGA_QSPI_SEND_16bI(40, &data_to_send[0], false);

A.2. SEcube™ - Receive

FPGA_QSPI_CONF(16777215, 1, 1);
uint16_t data_to_receive[10];
FPGA_QSPI_RECEIVE_16bI(9,&data_to_receive[0], false);

HAL_Delay(10000);

FPGA_IPM_DATA temp;
for (int i = 0; i < 3; i++) {

temp = data_to_receive[i] & 0xFF;
FPGA_IPM_open(2,0,0,0);
FPGA_IPM_write(2,1,&temp);
FPGA_IPM_close(2);
HAL_Delay(2000);
temp = data_to_receive[i] >> 8;
FPGA_IPM_open(2,0,0,0);
FPGA_IPM_write(2,1,&temp);
FPGA_IPM_close(2);
HAL_Delay(2000);

}
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